How to use OneNote Class

Notebook in Teams

By Dean Saghafi




= Every class team has its own linked OneNote Class

Where is the Notebook

= You can store text,images, handwritten notes,
N Ote bOO k attachments, links, voice, video, and more.
Found?




Student Notebooks
= Private space between the teacher and each student
= Teachers can access every student notebook

= Students can only access their notebook

EE]

Content Library

CO m po n e ntS Of = Read only space
th e N ote bOO k = Share handouts

Collaboration Space

= Everyone in the class can share, organize, and collaborate

Teacher only Space



W h ere d O yO U = General channel in the desired classroom team

. " You can create a notebook for each channel
find the

Notebook?

= Select the Class Notebook tab




= Create a Blank Notebook from scratch
= Copy content from an existing Notebook

= You can also create and access a Notebook directly
from OneNote

How to set up
your Class

Notebook

Give your students a private space for notes
and a canvas for collaboration.

Set up a OneMote Class Notebook

Blank Motebook

From existing notebook ccntentb




Manage

Notebooks

A
" Full screen mode «

= Select the expand tab

Conversations  Files  Class Notebook  Assignments  +
|

r,,‘_'] Distribute Page ~ === I:} Review Student Work B Create Assignrment

English 301 Motebook -

Saved

File Home Insert Dwanw Wiew Help Class Motebook Open in browser

B Manage Notebooks
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Manage your class Notebook settings
« Edit notebook sections
* Copy a link to your notebook
* Create a Teacher-only section group
* Lock the Collaboration Space
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Welcome
> _Collaboration Space
> _Content Library
> _Teacher Only
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How to Use Notebook to ...

How to Insert a PDF and a ...

How to insert and Article t...

Inserting a Quiz

Inserting Movies, Excel Spr...

Embedding Videos

How to Download the Enti...

How to Print a Page

Bugs in the Software

Screenshot

Class Notebook Assignments

< > 4 Search or type a command

Meeting Notes + O @

Class Notebook

v .

Open in browser v
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How to Use Notebook to Create and G

Sunday, May 31, 2020 3:25 PM
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Create a Page in Teacher Content

Go to Assighments in Teams

When click on Resources go to
Notebook and select the page
Distribute the page to the section you
want to distribute it in your students'
noteboooks

Grade the assignments either in
Notebook or in the Assignment
Section in Teams

Quizzes can be given inside Notebook
and the grades will show up in Excel
OR you can give the quizzes inside of
the assignment and the grade will
automatically show up in the
assignment grade pane when the
students complete them.



How to create a Section or a
Page




Sections and Pages can
be dragged up or down
to where you want move
them
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What can you do in the Notebook
tab?




General

File Home

Posts Files Class Notebook Assignments

Insert Draw View Help Class Notebook

Grades

Meeting Notes

Open in browser v
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How to Use Notebook to Create and Grade Assignments

Sunday, May 31, 2020 3:25PM
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Create a Page in Teacher Content

Go to Assignments in Teams

When click on Resources go to Notebook and
select the page

Distribute the page to the section you want to
distribute it in your students' noteboooks
Grade the assignments either in Notebook or
in the Assignment Section in Teams

Quizzes can be given inside Notebook and the
grades will show up in Excel OR you can give
the quizzes inside of the assignment and the
grade will automatically show up in the
assignment grade pane when the students
complete them.
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= When using the OneNote Notebook app in Teams or
online
= The Notebook does not allow you to copy and paste pages

from one Teacher-Only Section to another Teacher-Only
Section in another Notebook

= When you copy Content Library material you cannot copy
and paste individual pages from one Content Library to
another Content Library in another Notebook. You can
only copy and paste the ENTIRE section.

= You can copy and paste these individual pages using
the computer desktop app




You can connect Class

Notebook to your LMS or

SIS, such as Canvas or
PowerSchool

Allows you to create
assignments, assign
grades, track due dates,
and more, right from Class
Notebook. Your work will
sync automatically.

J

Connect Powerschool to

OneNote Notebook



https://www.youtube.com/watch?v=Wc1Tzk4Zxcs&_host_Info=onenote%7Cweb%7C16.00%7Cen-us%7Ca8a14e27-271c-236a-f77e-9b763e3f1bfd%7CisDialog%7C

What can you do in the Home tab?
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How to Use Notebook to Create and Grade As

Sunday, May 31,2020 3:25 PM To Do
Important
1. Create a Page in Teacher Content 7 Question
2. Go to Assignments in Teams
3. When click on Resources go to Notebook and select the page A Remember For Later
4. Distribute the page to the section you want to distribute it in your students' , Definiti
5. Grade the assignments either in Notebook or in the Assignment SectioninTi ™ efinition
6. Quizzes can be given inside Notebook and the grades will show up in Excel C Highliah
r ghlight
quizzes inside of the assignment and the grade will automatically show up in
pane when the students complete them. [25] Contact
ﬁ Address
\
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Password
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Project B

[T Movie To See
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What can you do in the Draw tab?
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How to Use Notebook to Create and Grade Assignments

Sunday, May 31, 2020 3:25PM

Create a Page in Teacher Content

Go to Assighments in Teams

When click on Resources go to Notebook and select the page

Distribute the page to the section you want to distribute it in your students' notebooks

Grade the assignments either in Notebook or in the Assignment Section in Teams

Quizzes can be given inside Notebook and the grades will show up in Excel OR you can give the
quizzes inside of the assignment and the grade will automatically show up in the assignment grade
pane when the students complete them.
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Math feature

= Takes handwritten equations and converts
them to text
= Solves and Graphs the equations

= The solution and the graphs canbe inserted into
the page fo the notebook

3
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= You can hand write notes into the Notebook

= Using

H a n d W rltl n g I n * Promethean or SmartBoard
th e N Ote b OO0 k = touch screenlaptop

= tabletor cell phone




What can you do in the Insert tab?
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? How to Use Notebook to Create and Grade Assignments

Sunday, May 31, 2020 3:25PM

Create a Page in Teacher Content

Go to Assignments in Teams

When click on Resources go to Notebook and select the page

Distribute the page to the section you want to distribute it in your students' notebooks

Grade the assignments either in Notebook or in the Assignment Section in Teams

Quizzes can be given inside Notebook and the grades will show up in Excel OR you can give the
quizzes inside of the assignment and the grade will automatically show up in the assignment grade
pane when the students complete them.
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Files that can be inserted

= ©

WORD FILES PDF FILES POWERPOINT FILES AS EXCEL SPREADSHEETS MOVIES UP TO 19 MB
PDF ASPDF

EMBED YOUTUBE EMBEDDING QUIZES LINKS TO ANY FILE OR
VIDEOS BY COPYING WEBSITE

AND PASTING THE URL



What can you do in the View tab?




General Posts Files Class Notebook Assignments Grades Meeting Notes

File Home Insert Draw View Help Class Notebook Open in browser

EO Navigation Panes v EH,') Immersive Reader Reading View @ Page Color v 'rﬁ‘j Page Versions

Bugs in the Software

Sunday, May 31, 2020 3:12 AM

1. When inserting a file it only allows you to upload a file from your computer. If you want to access
files from OneDrive, download the app to your computer.

2. Inserting Power point, Excel file has to be inserted as a PDF. The Notebook in Computer Teams app
will NOT do it. Using Notebook in online Teams will NOT do it. You have to use the OneNote app
on the computer and it will automatically convert the Power Point and Excel with a PDF of the file

3. Inserting Forms into a page with the Computer Teams app does not work. You have to do it on the
online version of Teams.

4. Insert File Print out is for BOTH PDF and Word documents

5. You can copy and paste YouTube video links right into the page and the video embeds itself right
into the page.

6. Cannot embed anything you want.

7. Syncing gets clunky and adding pages to all the students' notebooks takes a long time.

8. Can combine assignments into HW section of the notebook.

9. The Teams app online only allows you to Manage your Teams. It will not allow you to add or

remove students.
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Create a Page in
Teacher Content

S & o

When click on
Resources go to
Notebook and select
the page

Go to Assignments in
Teams

Distribute the page to
the section you want to
distribute it in your
students' noteboooks

Grade the assignments

either in Notebook or in

the Assignment Section
in Teams

Quizzes can be given
inside Notebook and
the grades will show up
in Excel OR you can
give the quizzes inside
of the assignment
section in Teams and
the grade will
automatically show up
in the assignment
grade pane when the
students complete
them.

How to Use Notebook to Create and Grade Assighments




= When you grade an assignment in the notebook it is
locked until you return the assignment

= After it is returnedthe student can revise the
assignment and turnit in again




You can create a backup copy of your
Notebook to OneDrive

Go to the online OneNote app and
click on Class Notebooks

You should create a backup since
OneDrive does not have your
Notebooks there. Notebooks are
automatically saved in the OneNote

app.
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Screenshot



@ililel'd o35t Click on the page you want to print

@1i1el'< o)1l Clickon File

How to Print a
Page

Select Print

You can Print to your printer, as a PDF,
or as a PDF to Google Drive
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Select a destination

Showing destinations for  dsaghafiez@gmail.com

Q. Bearch destinations

Save as POF

Canon TRBS500 series Canon TRASI0 series-AirPrint

Save to Goodle Drive  Save yeur document as & POF in Google Drive
Canon iPF6B0  Dean's MacBook Pro

Camon PRO-4000 Dean's MacSook Pro

EFS0M ET-4550 Series  EPS0M ET-4550 Series

FAX EPSON ET-4550 Series (IP) EPSOM ET-2550 Sedies

Photosmart 7520 series  HP Photosmart 7520 serles-AlrPrint
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When inserting a file it only allows you to upload a file from
your computer. If you wantto access files from OneDrive,
download the OneDrive app to your computer.

The OneNote app on the computer will automatically
convert Power Point and Excel files to a PDF file, NOT the
online version

Inserting Forms (Quizzes or surveys) into a page can only
be viewed on the online version of Teams.

Cannot embed anything you want.

Syncing gets clunky and adding pages to all the students'
notebooks takes a long time.

The Teams app online only allows you to Manage your
Teams. Itwill not allow you to add or remove students.
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Cannot find a way to import a Notebook. May not
be available for Mac

You can only save a Notebook Backup to
OneDrive.

There is a workaround to download it to your computer. After
creating a Notebook backup in OneDrive open the created
Notebook folder, click on the download button and all the
Notebooks are downloaded as a .zip files.

You can only print a single page within a section
in OneNote for Mac. You cannot print a PDF of the
entire notebook. Maybe in Windows?

No way to escape out of Reading View within
Teams. Must close out of Notebook and open the
Notebook up again.



Questions




